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Add Component

The Add Component command allows you to add a component to your assembly.

Details of Use

Since the Add Component command asks you to select from existing files, you have to have saved the component 
part first. 

The component is added such that the workplane in the component part with the name “base” is superimposed on 
the active workplane. The work axes are superimposed too. The name “base” can be in upper, lower or mixed case.
If there is no workplane called “base”, a sensible “upright” orientation for the component part is mapped onto the 
active workplane.

Remarks

The component part is referenced, not copied, so changes to the component part are automatically reflected in any
assemblies that use it.

You can use the information about the “base” workplane to position components in roughly the right place. To 
position a component specifically, you should use mating conditions. See Creating Mating Conditions for more 
information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Open Part in Context

The Open Part in Context command creates a new window showing the selected component part in the context of 
the active part.

Details of Use

You must select a part within the assembly, then choose the Open Part in Context command. A new window is 
created showing the component active in the context of the assembly. The window belongs to the component part, 
so the browser shows information about the component part.

Remarks

The Open Part in Context command allows you to design a part that is correct for its intended context. See Opening 
a Design in Context and Working on a Design in Context for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Product Structure

The Product Structure command allows you to examine the product structure of the active part.

Details of Use

A window is displayed in which you can browse the product structure, examine the parts list or bill of materials, 
and open component parts.

Remarks

As well as letting you examine the structure of an assembly, the Product Structure command is also a convenient 
way to open a component part. See Browsing the Product Structure for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Align Planes

The Align Planes command creates a mating condition that aligns the two selected planar faces so that they face 
the same way.

Details of Use

You must select two planar faces belonging to different component parts. The Align Planes command will move one 
of the components so that the faces become co-planar and face the same way. The component that was added to 
the assembly last will typically be moved.

Remarks

To align faces so that they face each other, use the Mate Planes command instead. See Creating Mating Conditions 
for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Mate Planes

The Mate Planes command creates a mating condition that aligns the two selected planar faces so that they meet, 
facing each other.

Details of Use

You must select two planar faces belonging to different component parts. The Mate Planes command will move one 
of the components so that the faces become co-planar and face each other. The component that was added to the 
assembly last will typically be moved.

Remarks

To align faces so that they face the same way, use the Align Planes command instead. See Creating Mating 
Conditions for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Center Axes

The Center Axes command creates a mating condition that aligns the axes of the two selected faces or edges.

Details of Use

You must select two faces that have axes, or two circular edges, belonging to different component parts. The 
Center Axes command will move one of the components so that the axes become co-linear. The component that 
was added to the assembly last will typically be moved.

Remarks

You cannot specify which way around the alignment should be, however, if you use the Align Planes or Mate Planes 
command to create further mating conditions, the alignment will be such that it satisfies these other mating 
conditions.

Having used the Center Axes command you can specify the rotational orientation about the alignment using the 
Orient Axes command. See Creating Mating Conditions for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Orient Axes

The Orient Axes command creates a mating condition that specifies the rotational orientation of two components 
about the alignment of axes specified by a Center Axes mating condition.

Details of Use

You must use the Center Axes command to align two axes, before the Orient Axes command is enabled. Then select 
two straight edges, one in each component, that you want to be parallel. One of the components will be rotated 
about the existing alignment axis such that these two edges become parallel and on the same side of the axis.

Remarks

Use the Center Axes command to specify the alignment of the axes first. See Creating Mating Conditions for more 
information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Mass Properties

The Mass Properties command gives you volume and surface area properties of the selected part.

Details of Use

If no part is selected, the mass properties of the active part are displayed.

Remarks

You can also use the Properties button in the window presented by the Product Structure command to get mass 
properties for a part. See Analyzing Your Assembly for more information.

See Also

{button ,AL(`assemblyMenu')} Related commands



Set Component Color

The Set Component Color command allows you to set the display color for the selected part.

Details of Use

In an assembly, the color you choose for the selected part will be used for all occurrences of that part within the 
assembly.

Note that you can also use the Set Component Color command to set the display color of a piece part. Just select 
the part itself, then use the command.

Remarks

When parts are created, and components are added to assemblies, a random color is used. Use the Set Component 
Color command to change this color if you do not like it. The color you choose is used for the shading in your view, 
and a darker form of the same color is used for the edges.

See Also

{button ,AL(`assemblyMenu')} Related commands
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Common Plane

The Common Plane command allows you to create a centerline representing the plane that passes through the 
selected features.

Details of Use

The Common Plane command can be used to create a centerline passing through two or more features that lie in 
the same plane. 

The most common example is a row of holes. Select the hole features first, then choose the Common Plane 
command. The major centerline that is created represents the plane that passes through the axes of the holes. 
Minor centerlines are also created perpendicular to the major center line, passing through each axis, and these 
represent planar features too. At the center of each hole, where the perpendicular centerlines cross, are 
centerpoints. These represent axial features.

You could also select two separated planar faces that lie in the same plane. The Common Plane command creates 
the extension line that connects the two planar faces to show that they are co-planar.

Remarks

Centerlines and centerpoints are features, just like faces and edges in your model. You can dimension to 
centerlines and centerpoints in the same way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands



Common Axis

The Common Axis command allows you to create a centerline representing the common axis that connects the 
selected co-axial features.

Details of Use

The Common Axis command is most commonly used with rotational parts. You can select the rotational feature at 
each end of the part and use the Common Axis command to create the common axis for the part.

Remarks

Centerlines are features, just like faces and edges in your model. You can dimension to centerlines in the same 
way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands



Mid-Plane (Center Line)

The Mid-Plane command on the Center Line menu allows you to create the mid-plane of the two selected planar 
features.

Details of Use

You must select two planar features. These could be centerlines, or faces. Then choose the Mid-Plane command to 
produce the centerline that represents the mid-plane feature.

Remarks

Centerlines are features, just like faces and edge in your model. You can dimension to centerlines in the same way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands



Pitch Circle

The Pitch Circle command creates a circular centerline passing through the axes of the selected features.

Details of Use

First select 3 or more end-on holes, then choose the Pitch Circle command. The circular centerline created 
represents the cylinder that contains the parallel axes of the selected holes. In addition, radial centerlines are 
created that represent planar features passing through each hole and the axis of the pitch circle feature.

Centerpoints are also created for each hole, representing the axis of the hole.

Remarks

Centerlines and centerpoints are features, just like faces and edge in your model. You can dimension to centerlines 
and centerpoints in the same way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands



Center Points

The Center Points command creates hole centerlines for the selected end-on circular features.

Details of Use

You should select one or more end-on axial features. Two centerlines and a centerpoint are created. The two 
centerlines represent planar features passing through the axis of the feature and oriented with the horizontal and 
vertical direction of the view on the drawing.

Remarks

If you only want the centerpoint, and not the two centerlines, you can edit the properties of each centerline in turn 
by double-clicking on it to bring up the Properties dialog. On the Center Lines page, turn off the “Draw center lines 
to boundary” option.

Centerlines and centerpoints are features, just like faces and edge in your model. You can dimension to centerlines 
and centerpoints in the same way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands



Phantom Intersection

The Phantom Intersection command allows you to construct the intersection of two planar features.

Details of Use

You must select two planar features that intersect, then choose the Phantom Intersection command. The features 
are extended if necessary to the point of intersection, and a centerpoint is created representing the end-on straight
feature at the intersection.

Remarks

Centerlines and centerpoints are features, just like faces and edge in your model. You can dimension to centerlines 
and centerpoints in the same way.

See Introduction to Feature-Based Drafting and Using Center Lines and Center Points for more information.

See Also

{button ,AL(`centerlineMenu')} Related commands
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Linear

The Linear command enters the mode for creating linear dimensions.

Details of Use

Having chosen the Linear command, you create linear dimensions by clicking on the first feature, and dragging 
from the second feature until the dimension line is in the desired position, then releasing the mouse button. The 
first feature remains highlighted as a datum, so you can drag from another second feature. To choose another first 
feature, click on the feature without dragging.

The status bar tells you whether the second feature is in a valid orientation for a linear dimension.

Remarks

When you dimension to circular features, the axis of the feature is used. To change to the near side or far side of 
the feature, double-click on either the dimension line or the dimension callout to bring up the properties, select the 
Measurement page, and change the measurement.

See Introduction to Feature-Based Drafting and Creating Single, Datum and Chained Dimensions for more 
information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Angular

The Angular command enters the mode for creating angular dimensions.

Details of Use

Having chosen the Angular command, you create angular dimensions by clicking on the first feature, and dragging 
from the second feature until the dimension line is in the desired position, then releasing the mouse button. The 
first feature remains highlighted as a datum, so you can drag from another second feature. To choose another first 
feature, click on the feature without dragging.

While you are dragging the dimension line, you can hold the SHIFT key down to get the major angle.

The status bar tells you whether the second feature is in a valid orientation for an angular dimension.

Remarks

You can create angular dimensions between two planar features. You can use center lines to construct planar 
features where you do not already have them. See Dimensioning the Angle Between 3 Holes for details.

See Introduction to Feature-Based Drafting and Creating Angular Dimensions for more information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Diametric

The Diametric command enters the mode for creating diametric dimensions.

Details of Use

Having chosen the Diametric command, you create diametric dimensions by dragging from the feature out to the 
desired position of the dimension line. The status bar tells you whether the feature is valid for a diametric 
dimension.

For an end-on circular feature, if you hold the SHIFT key down while dragging, the dimension line is constrained to 
pass through the center of the feature.

Remarks

The Diametric command uses a dimension line to display the dimension, whereas the Radial command uses a 
leader. To get a diametric dimension using a leader, or a radial dimension using a dimension line, you should create
the other dimension and then change its measurement. Just double-click on the dimension callout, select the 
Measurement page, and toggle the measurement between diametric and radial.

See Introduction to Feature-Based Drafting and Controlling Styles and Measurements for more information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Radial

The Radial command enters the mode for creating radial dimensions.

Details of Use

Having chosen the Radial command, you create radial dimensions by dragging from the feature out to the desired 
position of the dimension text. The status bar tells you whether the feature is valid for a radial dimension.

Remarks

The Radial command uses a leader to display the dimension, whereas the Diametric command uses a dimension 
line. To get a diametric dimension using a leader, or a radial dimension using a dimension line, you should create 
the other dimension and then change its measurement. Just double-click on the dimension callout, select the 
Measurement page, and toggle the measurement between diametric and radial.

See Introduction to Feature-Based Drafting and Controlling Styles and Measurements for more information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Geometric Tolerance

The Geometric Tolerance command enters the mode for creating feature control symbols for geometric tolerances.

Details of Use

Having chosen the Geometric Tolerance command, you create geometric tolerances by dragging from the feature 
out to the desired position of the feature control symbol. The symbol initially appears with the text “Tolerance”. You
can specify the details of the geometric tolerance by double-clicking on the symbol and entering the tolerance type,
value, and any datums. Only existing datums are presented in this dialog, so you must label datum features first 
using the Datum Feature command.

If you hold the SHIFT key down while dragging the feature control symbol, the symbol will be attached to the 
feature instead of being directed using a leader.

You can also drag from dimension lines. This creates a feature control symbol for the mid-plane or axis of the 
dimensioned feature. If you hold the SHIFT key down, the symbol will be attached to the dimension line as an 
additional callout group.

Remarks

If the feature you want to use already has a dimension or datum label callout, you can create a feature control 
symbol by selecting the callout, and then using the Insert Callout command to insert a symbol into the same callout
group. Then use the arrow keys or the ENTER key to move the new callout to the desired position within the callout
group.

See Feature-Based Tolerancing for a conceptual overview on geometric tolerances in DesignWave. See Adding 
Datum Labels and Adding Feature Control Symbols for more on creating geometric tolerances.

See Also

{button ,AL(`dimensionMenu')} Related commands



Datum Feature

The Datum Feature command enters the mode for creating datum labels for geometric tolerances.

Details of Use

Having chosen the Datum Feature command, you create datum labels by dragging from the feature out to the 
desired position of the label. The symbol initially appears with the text “Datum”. You can specify the name of the 
datum label by double-clicking on the symbol and entering the name in the Properties dialog. 

If you hold the SHIFT key down while dragging the datum label, the label will be attached to the feature instead of 
being directed using a leader.

You can also drag from dimension lines. This creates a datum feature that is the mid-plane or axis of the 
dimensioned feature. If you hold the SHIFT key down, the label will be attached to the dimension line as an 
additional callout group.

Remarks

If the feature you want to label already has a dimension or geometric tolerance callout, you can create a datum 
label by selecting the callout, and then using the Insert Callout command to insert a datum label into the same 
callout group. Then use the arrow keys or the ENTER key to move the new callout to the desired position within the
callout group.

See Feature-Based Tolerancing for a conceptual overview on geometric tolerances in DesignWave. See Adding 
Datum Labels and Adding Feature Control Symbols for more on creating geometric tolerances.

See Also

{button ,AL(`dimensionMenu')} Related commands



Note

The Note command enters the mode for creating textual notes.

Details of Use

Having chosen the Note command, you create notes by dragging from a feature out to the desired position of the 
text. You can create free standing notes by dragging when a feature is not pre-highlighted. The note initially 
appears with the text “Note”. You can specify the text you want by double-clicking on the note callout and entering 
the text in the Properties dialog. 

If you hold the SHIFT key down while dragging the note from a feature, the text will be attached to the feature 
instead of being directed using a leader. If you hold the SHIFT key down while dragging a free standing note, the 
note will be created without a leader.

You can also drag from dimension lines. This creates a note that is attached to the dimension line as an additional 
callout group.

Remarks

If you want to add a note to an existing callout group, perhaps as a prefix to some dimension text, you can select 
the existing callout and then choose the Insert Callout command. Alternatively, you can select the existing callout 
and just press the INSERT key. If need be, you can use the arrow keys or the ENTER key to move the new callout 
to the desired position within the callout group.

See Also

{button ,AL(`dimensionMenu')} Related commands



Insert Callout

The Insert Callout commands allows you to insert a new callout into an existing callout group.

Details of Use

First select an existing callout, then choose one of the Insert Callout commands. You can always insert a note, but 
the other callouts can only be inserted if you have selected a callout that is not a note. This is because note 
callouts are just text, and do not identify a feature, whereas the other callouts do.

The new callout is inserted before the selected callout. You can double-click on the new callout to set its properties.

Remarks

If need be, you can use the arrow keys or the ENTER key to move the new callout to the desired position within the
callout group.

See About Callouts and Callout Groups for a conceptual overview, and see Using the Clipboard with Callouts for 
more information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Move Callout

The Move Callout commands allow you to re-format the callouts within a callout group.

Details of Use

First select a callout. Then use the Move Callout commands to move the callout within the callout group. You will 
find the arrow key and ENTER key short cuts useful when doing this.

Remarks

See About Callouts and Callout Groups for a conceptual overview, and see Using the Clipboard with Callouts for 
more information.

See Also

{button ,AL(`dimensionMenu')} Related commands



Shoulder

The Shoulder commands allow you to change the shoulder for the selected callout group attached to a dimension 
line, or the selected leader.

Details of Use

For a callout group attached to a dimension line, you can use the Shoulder commands to apply a shoulder where 
there is not already one, to change the shoulder to the other side, or to remove a shoulder. The direction of the 
shoulder is relative to the dimension line.

For a leader, you can use the Shoulder commands to change the shoulder to the opposite side of the callout group. 
The direction of the shoulder is relative to the callout group.

Remarks

You can set a specific length for the shoulder of a leader by double-clicking on the leader and selecting the Leader 
page in the Properties dialog.

You can set a specific length for the shoulder of a callout group attached to a dimension line by double-clicking on 
the callout group and selecting the Placement page in the Properties dialog.

See Also

{button ,AL(`dimensionMenu')} Related commands



This is before the first topic, so it will not get displayed

Notes can go here. 



Add Modeling View

The Add Modeling View command allows you to add a principle view to your drawing.

Details of Use

The command offers you a list of part windows currently open. The view of the part window you choose is placed 
on the drawing, so you should set up the view direction beforehand. Changing the view direction of the part 
window afterwards does not affect the drawing.

Remarks

See Adding the Principle View for more information.

See Also

{button ,AL(`drawingMenu')} Related commands



Add Projected View

The Add Projected View command allows you to add a secondary view that is a projection of the selected feature.

Details of Use

Select a planar or staight feature first, and then choose the Add Projected View command. The projected view is 
initially placed near the center of the drawing. Drag the view by its bounding box to position it to one side or other 
of the principle view, according to whether you use a 1st or 3rd angle projection scheme.

If you hold the SHIFT key down while dragging the view, its alignment with the principle view will be maintained.

Remarks

See Creating Projected Views for more information.

See Also

{button ,AL(`drawingMenu')} Related commands



Add Section View

The Add Section View command allows you to add a section view to the drawing.

Details of Use

Before you use the Add Section View command, you must define the section cut in terms of an existing view using a
sketch. After you have defined the section cut sketch, select the view to be sectioned and then choose the Add 
Section View command. You can specify that sketch in the dialog window that is presented.

Remarks

The lines in the section cut sketch determine the many types of section view that are possible. See About Section 
Views for more information.

See Also

{button ,AL(`drawingMenu')} Related commands



Align Other Views

The Align Other Views command aligns other views with the selected view, if possible.

Details of Use

Select a view, and then choose the Align Other Views command. Any other view that is related to the selected view 
by projection rules is aligned.

Remarks

When moving secondary views around by dragging, you can maintain or re-instate alignment with their principle 
view, by holding the SHIFT key down.

See Also

{button ,AL(`drawingMenu')} Related commands



Update Views

The Update Views command re-calculates hidden line views.

Details of Use

The Update Views command is presented as a button on the drawing toolbar. The button is enabled if any of the 
views on the drawing is out of date. When you change a part that is shown on a drawing, the drawing view reverts 
to a wire frame image until such time as you use the Update Views command.

Remarks

See Introduction to Drawings for more information.

See Also

{button ,AL(`drawingMenu')} Related commands



Sheet Setup

The Sheet Setup command allows you to examine or modify the properties of the drawing.

Details of Use

You can change the format, the size, of the default view scale in the Properties dialog that is presented.

Remarks

You can even change these properties after there are views and dimensions on the drawing. So if you decide that 
you need a bigger sheet size, you can change the format or size without having to start over.

See Also

{button ,AL(`drawingMenu')} Related commands
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Undo

The Undo command allows you to undo the last command you used.

Details of Use

The Undo command allows you to recover when you make a mistake. You can even undo many severe actions, 
such as closing a part and discarding changes you made. The main toolbar has a button for the Undo command. 
The command that would be undone is shown next to this button.

Remarks

Window and viewing commands are not affected by Undo. So you can create a line, zoom in, create a new window, 
turn shading on, and still be able to undo the creation of the line.

See Also

{button ,AL(`editMenu')} Related commands



Cut

The Cut command allows you to move objects by placing them on the clipboard ready to be pasted using the Paste 
command.

Details of Use

First select the objects to be cut, then choose the Cut command. The command works on lines in sketches, and on 
callouts in drawings.

Remarks

When you use the Cut command, the selected objects are shown with dotted boxes around them to indicate that 
they are on the clipboard. To clear the clipboard and remove these boxes, you can press the ESCAPE key.

Objects that are cut are not removed from their original location until you later paste them.

See Also

{button ,AL(`editMenu')} Related commands



Copy

The Copy command allows you to create copies of the selected objects. Copies are produced when you later use 
the Paste command.

Details of Use

First select the objects to be cut, then choose the Copy command. The command works on lines in sketches, and 
on callouts in drawings.

Remarks

When you use the Copy command, the selected objects are shown with dotted boxes around them to indicate that 
they are on the clipboard. To clear the clipboard and remove these boxes, you can press the ESCAPE key.

See Also

{button ,AL(`editMenu')} Related commands



Paste

The Paste command takes the objects on the clipboard and inserts them into the current context.

Details of Use

To use the Paste command you must first have used either the Cut or the Copy command. If you had use the Cut 
command, the Paste command will remove the objects from their original context and insert them into the current 
context. If you had used the Copy command, the Paste command will insert copies of the objects in the current 
context, and leave the original objects on the clipboard so that they can be pasted a second time.

Remarks

The Paste command works on lines in sketches, and on callouts in drawings. See Using the Clipboard with Lines and
Using the Clipboard with Callouts for more information.

See Also

{button ,AL(`editMenu')} Related commands



Delete

The Delete command deletes the selected objects.

Details of Use

First select the objects, then choose the Delete command. 

Remarks

Sketches can be deleted using the Delete button in the dialog window presented by the Sketches command. Mating 
conditions can be deleted using the Delete command on the popup menu in the component browser.

Some objects cannot be deleted because they are “in use”. Examples are workplanes that contains sketches that 
are used by features, and centerlines in drawings that are being displayed due to dimension line properties. In such
cases, you will get a message box telling you that some of the selected objects were not deleted.

See Also

{button ,AL(`editMenu')} Related commands



Select All

The Select All command allows you to select all objects of the type implied by the current mode.

Details of Use

What gets selected when you use Select All, depends on the current mode. For example, if you are selecting lines 
or creating lines, Select All will select all lines in the active sketch; if you are selecting annotations or creating 
dimensions, Select All will select all annotations in the drawing.

Remarks

You can select “everything except …” by first using Select All, and then de-selecting specific objects by holding the 
SHIFT key down while you click in the view.

See Also

{button ,AL(`editMenu')} Related commands



Shift Point-to-Point

The Shift Point-to-Point command allows you to translate the selected objects within the active workplane.

Details of Use

You must first select the objects to be translated. You can select lines or components. Then choose the Shift Point-
to-Point command. You will enter a mode for dragging a translation vector in the active workplane. All the usual 
attraction points are selectable, as if you were creating a straight line, to allow you to specify a precise translation.

Remarks

If you want to translate by a specific vector, or you want to scale or rotate the objects, you should use the 
Transform command instead.

Although you can use the Transform and Shift Point-to-Point commands to move assembly components within the 
active workplane, mating conditions are more appropriate for positioning components precisely relative to one 
another. See Creating Mating Conditions for more information.

See Also

{button ,AL(`editMenu')} Related commands



Transform

The Transform command allows you apply a specific transformation within the active workplane to the selected 
objects.

Details of Use

You must first select the objects to be translated. You can select lines or components. Then choose the Transform 
command. You can choose from Translate, Rotate, or Scale. You cannot scale assembly components. All 
transformations are within the active workplane and are in terms of the 2D coordinate system defined by the 
current position and orientation of the work axes.

Remarks

You can also use the Shift Point-to-Point command if you want to drag a translation vector in terms of existing 
points in the workplane.

Although you can use the Transform and Shift Point-to-Point commands to move assembly components within the 
active workplane, mating conditions are more appropriate for positioning components precisely relative to one 
another. See Creating Mating Conditions for more information.

See Also

{button ,AL(`editMenu')} Related commands



Duplicate

The Duplicate command allows you to create multiple copies of the selected objects.

Details of Use

You must first select the objects to be translated. You can select lines or components. Then choose the Duplicate 
command. You can choose from a rectangular or circular array of copies. The array is within the active workplane 
and in terms of the current location and orientation of the work axes.

Remarks

If you duplicate a component that has mating conditions, the copies do not have mating conditions. If the position 
of the original component should change because of mating conditions updating, the copies will not automatically 
update.

See Also

{button ,AL(`editMenu')} Related commands



Properties

The Properties command allows you to examine or modify the properties of the selected object.

Details of Use

You must first select a single object. Then choose the Properties command. As a short cut, you can double-click on 
an object to select it and access its properties in one step. Properties are grouped into pages. You can move 
between the pages and make changes on any of them.

For a face or edge, the Properties command brings up the properties for the feature that produced that face or 
edge.

Remarks

To change the properties of multiple objects, you should first change one of them, and then use the Pick Up 
Properties and Apply Properties commands to affect the others. See Pasting Line Properties and Copying Styles to 
Other Objects for more information.

To examine or modify the properties of a sketch, you can either use the Properties command on the popup menu in
the browser, wherever you can see the sketch, or you can use the Properties button presented in the dialog window
of the Sketches command.

See Also

{button ,AL(`editMenu')} Related commands



Pick Up Properties

The Pick Up Properties command allows you take a copy of selected properties of an object ready for using the 
Apply Properties command.

Details of Use

The dialog window presents the properties that the object has. Only those properties that you select will be picked 
up. Then you can use the Apply Properties command to apply just those properties to a selection of other objects to
which those properties can apply.

Remarks

See Pasting Line Properties and Copying Styles to Other Objects for more information. To change the properties of 
an object, use the Properties command.

See Also

{button ,AL(`editMenu')} Related commands



Apply Properties

The Apply Properties command allows you apply properties to the selected objects.

Details of Use

You must first use the Pick Up Properties command to copy specific properties from an object. The Apply Properties 
command will then apply the properties you chose to the objects that are now selected.

Remarks

See Pasting Line Properties and Copying Styles to Other Objects for more information. To change the properties of 
an object, use the Properties command.

See Also

{button ,AL(`editMenu')} Related commands
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Extrude Profile

The Extrude Profile command creates a feature by extruding a sketch profile.

Details of Use

First create the profile you want to use in a sketch all by itself. Then use the Extrude Profile command to extrude 
that profile to produce or remove solid material.

Remarks

The topic About Profiles explains what constitutes a valid profile. Topis Creating the Basic Shape and Adding 
Bosses, Pads and Pockets describe when to extrude profiles.

See Also

{button ,AL(`featureMenu')} Related commands



Project Profile

The Project Profile command creates a feature by projecting a profile onto your model.

Details of Use

First create the profile you want to use in a sketch all by itself. Then use the Project Profile command to project that
profile to add or remove solid material.

Remarks

The topic About Profiles explains what constitutes a valid profile. See Projecting Profiles onto Your Model for more 
on projected profiles.

See Also

{button ,AL(`featureMenu')} Related commands



Revolve Profile

The Revolve Profile command creates a feature by revolving a sketch profile about an axis.

Details of Use

The Revolve Profile command takes two sketches as input, one for the profile and one for the axis. You can create 
the sketches in either order. The two sketches should belong to the same workplane.

The axis sketch must contain a single straight line representing the axis of revolution for the feature. This line 
should be a firm line, not a construction line. Construction lines in the sketch are ignored. The axis must not cut 
through the profile. It can lie along one side of the profile, so that the revolved feature has no hollow core, or it can
lie away from the profile so as to produce a hollow core.

The profile is rotated 360 degrees about the axis.

Remarks

The topic About Profiles explains what constitutes a valid profile. See Adding Revolved Features for more on 
revolved profiles.

See Also

{button ,AL(`featureMenu')} Related commands



Sweep Profile

The Sweep Profile command creates a feature by sweeping a profile along a path.

Details of Use

The Sweep Profile command takes two sketches as input, one for the profile and one for the path. You can create 
the sketches in either order. The workplane containing the profile must be perpendicular to the path at the point 
where it cuts the path.

The path must be a single line chain containing straight lines or circular arcs. The line chain can be open or closed. 
You can have corners where two straight lines meet, but junctions involving arcs must be smooth continuations.

Remarks

The topic About Profiles explains what constitutes a valid profile. See Creating Pipes, Grooves, and Lips for more on
swept profiles.

See Also

{button ,AL(`featureMenu')} Related commands



Blend Edges

The Blend Edges command creates a blend or chamfer feature.

Details of Use

First you must select one or more edges to blend. The edges do not have to be connected. The dialog window 
presented provides an option for automatically propagating along other smooth connected edges, so there is no 
need to select all edges in such cases.

You can create blends and chamfers with the Blend Edges command. Chamfers are defined as the chordal cut that 
spans the limits of an equivalent blend surface. Note that for a 90-degree edge, the set-back distance is the same 
as the radius of an equivalent blend, but for other edges, the chamfer value is not the set-back distance.

Remarks

See Adding Blends, Fillets, and Chamfers for more information.

See Also

{button ,AL(`featureMenu')} Related commands



Hollow Solids

The Hollow Solids command removes the selected faces and gives thickness to the remaining faces so as to hollow 
out the part.

Details of Use

Select the faces first, then choose the Hollow Solids command and enter the thickness. The remaining faces 
become the outside faces of the part, and new inner faces are produced as the part is hollowed out. The thickness 
is the separation between the outer and inner faces.

Remarks

See Creating Thin Walled Parts for more information.

See Also

{button ,AL(`featureMenu')} Related commands



Use Component

The Use Component command creates a feature using the selected assembly component.

Details of Use

Select a single assembly component that belongs directly to the active part, then choose the Use Component 
command to add or remove solid material in the active part. 

The component form and position is used to produce solid material. You can choose whether to add, remove or 
intersect this material with the existing part, if any. Finally, the component is hidden. You can use the component 
browser to see that the component is hidden, and to unhide it if need be.

Remarks

The Use Component command is used to produce derived models. See About Derived Models for more information.

See Also

{button ,AL(`featureMenu')} Related commands



Uncondemn All

The Uncondemn All command allows you to change your mind about condemned features that have not yet been 
removed from the part.

Details of Use

All features in the part that are currently condemned are uncondemned.

Remarks

You can use the Condemn command on the popup menu in the feature browser to condemn a feature. Condemned 
features are not deleted until next time the design is updated. You can use the Uncondemn All command if you 
change your mind about deleting those features. See Condemning Features for more information.

See Also

{button ,AL(`featureMenu')} Related commands



Update Design

The Update Design command updates your part to show the affect of changes you have made to features.

Details of Use

The Update Design command is presented as a button on the modeling toolbar. If the design needs updating, the 
button is enabled. The design will need updating if you have made changes to features, such as modifying a profile,
or using the Properties command to edit feature parameters.

Remarks

See Making Changes to Your Features for more on modifying features.

When the design is being updated, sometimes a feature can fail. In such situations, you are presented with a 
message box explaining the problem. You can press the F1 key for more information on the message. See Why 
Update Design can Fail for more information.

See Also

{button ,AL(`featureMenu')} Related commands
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New

The New command is used to create a new part or drawing.

Details of Use

Select the type of document – part or drawing – you want to create. The new part or drawing appears in a new 
window. To save you work, use the Save command. 

Remarks

Parts and drawings are saved in files. See Saving Your Work for more on file types.

See Also

{button ,AL(`fileMenu')} Related commands



Open

The Open command allows you to open an existing file.

Details of Use

Select the file you want in the dialog window that is presented. You can open part, drawing or session files with the
Open command. You can also open Parasolid transmit files and these will be converted into a DesignWave part for 
you.

Remarks

Parts and drawings are saved in files. See Saving Your Work for more on file types. See Importing and Exporting 
Parts for information on Parasolid transmit files.

See Also

{button ,AL(`fileMenu')} Related commands



Close

The Close command allows you to close all windows of your part or drawing.

Details of Use

If any changes have been made, you will be prompted to save these changes before the document is closed. If you
close a part and choose to discard changes, the part will automatically revert back to the last saved version when 
used as a component in an open assembly, or shown in a view on an open drawing.

Remarks

To close just the active window, you can use the Close command on the window itself. Closing the last window of a 
document is the same as using the Close command on the File menu.

See Also

{button ,AL(`fileMenu')} Related commands



Save

The Save command allows you to save any changes you have made to your part or drawing.

Details of Use

If the part or drawing has references to other files that also need saving – for example an assembly contains 
components that have changed – you wll be prompted to save those files first.

Remarks

If any changes have been made, an asterisk will be displayed in the title bar of all windows of that document.

See Also

{button ,AL(`fileMenu')} Related commands



Save Copy As

The Save Copy As command allows you to save a copy of the active document under a different pathname.

Details of Use

Unlike other applications that commonly have a Save As command, the Save Copy As command does not rename 
the active document. The copy that is saved has the name you supply. This is so that any other files that might 
reference the document file are unaffected.

The Save Copy As command is not enabled until you have used the Save command once.

Remarks

To save a copy of the current session, use the Save Session As command.

See Also

{button ,AL(`fileMenu')} Related commands



Save as VRML

The Save as VRML command allows you to create a VRML file of the part displayed in the active window.

Details of Use

Choose a filename for the VRML file. A VRML v1 output file will be written, containing all the solids and assembly 
components.

Remarks

VRML files can be viewed using many different applications. See Importing and Exporting Parts for more on VRML 
files.

See Also

{button ,AL(`fileMenu')} Related commands



Close All

The Close All command allows you to close all windows in your session.

Details of Use

If any changes have been made, you will be prompted to save these changes before windows of that part or 
drawing are closed. The Close All command does not start a new session. If you have opened an existing session 
file and you then use Close All, saving the session now will record the fact that no windows are open.

Remarks

To close all windows of a particular part or drawing, you can use the Close command.

See Also

{button ,AL(`fileMenu')} Related commands



Save Session

The Save Session command allows you to record all the windows you have open, so you can return to this state 
again later and continue working.

Details of Use

The Save Session command records all the window positions and sizes, including whether windows are minimized. 
It also records whether views are shaded and in admire mode, and the view direction, zoom and pan for all views.

Remarks

You can use Save Session to snapshot work in progress, or to save a collection of parts and drawings that represent
a project or some sort. See Saving Your Work for more information.

See Also

{button ,AL(`fileMenu')} Related commands



Save Session As

The Save Session As command allows you to save a copy of the current session to a file.

Details of Use

The Save Session As command records all the same information as the Save Session command, only it saves a copy
of the current session, rather than overwriting it.

Remarks

See Saving Your Work for more information.

See Also

{button ,AL(`fileMenu')} Related commands



Print

The Print command allows you to send a hardcopy of the active document to the printer or plotter.

Details of Use

For part windows, the Print command will give you a picture of the active window, including split panes. 

For drawings, the Print command will plot your drawing. The dialog window presents options that affect the scale 
and resolution of the plot.

Remarks

Only raster printing and plotting devices – such as laser, bubble jet, and ink jet - are supported. Vector devices – 
such as pen plotters – are not supported.

See Also

{button ,AL(`fileMenu')} Related commands



Print Setup

The Print Setup command allows you to select the printer or plotter to use and various options for that device.

Details of Use

The dialog window that is presented allows you to select the printer or plotter, the paper size and the paper 
orientation for future use of the Print command.

Remarks

You can also use the Setup button in the Print command dialog window instead.

See Also

{button ,AL(`fileMenu')} Related commands



List of Recently Opened Files 

This menu entry shows a recently opened file.

Details of Use

You can select a recently opened file from the File menu as a short cut for opening it again.

Remarks

The File menu has a list of up to 8 recently opened files. Note that a file is presented here, even if that file has 
since been deleted or renamed, perhaps using the Windows Explorer. If you select a file that no longer exists, you 
will get a message indicating this.

See Also

{button ,AL(`fileMenu')} Related commands



Exit

The Exit command closes the DesignWave application.

Details of Use

If any changes have been made to parts or drawings, you will be prompted to save these changes first. You will 
also be prompted to save the current state of the session to a file.

Remarks

See Saving Your Work for more information.

See Also

{button ,AL(`fileMenu')} Related commands
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Help Topics

The Help Topics command takes you to the on-line help.

Details of Use

The Contents, Index, and Find pages of the on-line help window allow you to access help topics.

Remarks

For information on context-sensitive help, see Using Context-Sensitive Help.

See Also

{button ,AL(`helpMenu')} Related commands



Using Help

The Using Help command gives you help about using the help system itself.

Details of Use

You will be presented with general help on how to use Windows on-line help.

Remarks

For help on DesignWave, use the Help Topics command.

See Also

{button ,AL(`helpMenu')} Related commands



Context Sensitive Help

The Context Sensitive Help command displays the help cursor to allow you to access context-sensitive help.

Details of Use

With the help cursor displayed, you can click on any menu command, toolbar button, or anywhere in a window to 
get help on that subject.

Remarks

You can also get context-sensitive help on a menu command by pressing F1 before you release the mouse button.

See Also

{button ,AL(`helpMenu')} Related commands



Tip of the Day

The Tip of the Day command offers you tips for more productive use of DesignWave.

Details of Use

The dialog window has a setting to say whether you want tips displayed at startup. If tips are not displayed at 
startup, you can use the Tip of the Day command to access the tips.

Remarks

Tips are stored in a tips.txt file in the same folder as the DesignWave application. You can edit this file to add 
further tips if you want. The format is explained at the top of the file.

See Also

{button ,AL(`helpMenu')} Related commands



Support

The Support menu gives you access to up to date information about DesignWave, including Frequently Asked 
Questions.

Details of Use

You need to have a web browser set up to use this command.

Remarks

See Support for related information.

See Also

{button ,AL(`helpMenu')} Related commands



About DesignWave

The About DesignWave command allows you to view information about which version of DesignWave is running.

Details of Use

You will be presented with a window that tells you information about the version of the software, and other related 
information. You can press the Computervision button to go to the Computervision web site.

Remarks

For more about the web site, see On-Line Support.

See Also

{button ,AL(`helpMenu')} Related commands
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Straight

The Straight command enters the mode for creating straight lines.

Details of Use

Having chosen the Straight command, you can create straight lines by dragging in the view. To create a straight 
line, press the mouse button down at the start point, and drag to the end point, then release the button. Attraction
points, such as end points and intersection points, are shown as black squares as you move over them, so you can 
select precise points.

When creating straight lines, you can select the circumference of a circle or arc in order to produce a straight line 
that is tangent to it.

If you hold the SHIFT key down, while dragging, the straight line will be constrained to lie parallel to one of the 
work axes directions. This allows you to produce horizontal and vertical lines easily.

Remarks

You can create an arc through 3 points, by first creating a straight line, and then bending the line to pass through 
the 3rd point. See Creating Lines for more information on creating lines and selecting attraction points.

See Also

{button ,AL(`lineMenu')} Related commands



Circle

The Circle command enters the mode for creating circular lines.

Details of Use

Having chosen the Circle command, you can create circles by dragging in the view. To create a circle, press the 
mouse button down at the center point, and drag to the circumference point, then release the button. Attraction 
points, such as end points and intersection points, are shown as black squares as you move over them, so you can 
select precise points.

Remarks

See Creating Lines for more information on creating lines and selecting attraction points.

See Also

{button ,AL(`lineMenu')} Related commands



Rectangle

The Rectangle command enters the mode for creating rectangles.

Details of Use

Having chosen the Rectangle command, you can create rectangles by dragging in the view. To create a rectangle, 
press the mouse button down at one corner, and drag to the diagonally opposite corner, then release the button. 
Attraction points, such as end points and intersection points, are shown as black squares as you move over them, 
so you can select precise points.

The Rectangle command creates 4 independent straight lines.

The orientation of the rectangle is take from the orientation of the work axes.

Remarks

Use the Reposition Axes or Transform Axes command to change the orientation of the work axes. See Creating Lines
for more information on creating lines and selecting attraction points.

See Also

{button ,AL(`lineMenu')} Related commands



Fillet

The Fillet command enters the mode for filleting the intersections of lines.

Details of Use

The dialog window allows you to enter the fillet radius to use. Then you drag in the graphical view to create fillets. 
You can only fillet lines that meet or intersect. As you move the cursor around pairs of suitable lines pre-highlight. 
Press the mouse button down over the intersection of the lines and drag the cursor to indicate which segment you 
want, then release the mouse button.

You can create fillet arcs for segments outside the extent of the lines. If the fillet arc joins within the extent of the 
line, the line is trimmed back to meet the fillet arc, otherwise the line is not trimmed.

To cancel the fillet, you can press the ESCAPE key.

Remarks

To fillet two lines that do not meet, you must extend them first so that they do. To extend a line, first select it, and 
then drag an end point with the SHIFT key held down so as to maintain its underlying geometry.

See Also

{button ,AL(`lineMenu')} Related commands



Delete Segments

The Delete Segments command enters the mode for deleting line segments.

Details of Use

Having chosen the Delete Segments command, you can delete line segments in the view. A line segment is a portion
of a line between intersections or end points. As you move the cursor around, line segments are pre-highlighted. 
Click on a segment to delete it, or click with the SHIFT key held down to delete all of the line except for that 
segment.

Remarks

The Delete Segments command will also let you delete entire lines. To delete several entire lines, it is better to 
select the lines and use the Delete command.

See Also

{button ,AL(`lineMenu')} Related commands



Mirror

The Mirror commands allow you to create mirror images of the selected lines.

Details of Use

First select the lines. Then choose one of the mirror commands. The mirror command create mirror images in the 
work axes. You should position and orient the work axes first using the Reposition Axes or Transform Axes 
command.

Remarks

You can use the Mirror commands to construct symmetric profiles. Since the mirror images are independent lines 
once created, it is best to use the Mirror commands last.

See Also

{button ,AL(`lineMenu')} Related commands



Offset Chain

The Offset Chain command allows you to create a chain of lines that is a constant offset distance from the selected 
chain of lines.

Details of Use

The selected lines must form a chain, that is, they must be connected end-to-end. For a closed loop of lines, you 
can specify whether to offset inwards or outwards. For an open chain, both sides will be generated, and you can 
delete the side that you did not want.

If you offset by an amount which is greater than the local size of 2D features in the line chain, the offset chain can 
contain a different number of lines. In some cases, the offset result can be more than one chain.

Remarks

To select a chain of lines, ready for using the Offset Chain command, you can just select one of the lines and then 
use the Add Connected Lines command on the Select menu.

See Also

{button ,AL(`lineMenu')} Related commands



Project Edges

The Project Edges command allows you to project edges onto the active workplane to produce lines in the active 
sketch.

Details of Use

Straight or circular edges must be selected. The lines created are independent of the edges from which they came, 
so they can be modified.

Remarks

If you open a part in context, you can use the Project Edges command to project edges from a mating part, so as 
to design a feature that is the correct shape and size for its situation. See Opening a Design in Context for more 
information.

See Also

{button ,AL(`lineMenu')} Related commands



Toggle Construction

The Toggle Construction command allows you to convert between firm lines and construction lines.

Details of Use

First select the lines you want to convert. Then choose the Toggle Construction command. Firm lines are converted 
to construction lines, and construction lines are converted to firm lines.

Remarks

Construction lines are not considered part of profiles. See About Profiles for more information.

Construction lines have special significance when defining section view cuts. See About Section Views for more 
information.

See Also

{button ,AL(`lineMenu')} Related commands
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Suppress

The Suppress command allows you to take a feature out of service until further notice.

Details of Use

The feature under the cursor is suppressed. You can use the Suppress command a second time to unsuppress the 
feature again.

The check mark next to the command on the popup menu tells you whether the feature is currently suppressed. 
The icon in the browser for the feature also gives you this information.

Remarks

You will not see the affect of suppressing the feature until you use the Update Design command to update your 
model. See Suppressing Features for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Condemn

The Condemn command allows you to mark a feature for deletion.

Details of Use

The feature under the cursor is condemned. A black cross over the icon in the browser shows you that it is 
condemned. Any dependent features are also condemned, and you are told about this.

Remarks

Since the view of your model does not update to show the affect of removing the feature until such time as you use
the Update Design command, the feature is condemned - marked for deletion – until you update the design. This is 
so that the browser and the view are consistent with each other. For example, you can still select an edge or face 
of the condemned feature in the view and use the Synchronize Browser command to find that feature in the 
browser.

You can use the Uncondemn All command to uncondemn all features.

See Condemning Features for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Explain Problem

The Explain Problem command tells you what is wrong with the object under the cursor.

Details of Use

You can use the Explain Problem command wherever you see an icon in the browser that has a problem. This is 
whenever there is a  mark or a 

 mark on the icon. A message window is displayed to explain the situation. You can press the F1 key when the 
message is displayed to get more information and suggested courses of action.

Remarks

See Why Update Design can Fail for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Select Workplane, Select Component

The Select Workplane and Select Component commands allow you to select the object represented by the icon under
the cursor.

Details of Use

Use the Select Workplane command in the browser to highlight the workplane in the graphical view.

Use the Select Component command in the browser to highlight the component in the graphical view.

Remarks

See Using the Workplane Browser and Using the Component Browser for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Hide

The Hide command allows you to hide or show a component in the assembly.

Details of Use

The check mark next to the Hide command on the popup menu tells you whether the component is currently 
hidden. Use the Hide command a second time to show the component again. The icon for the component in the 
browser also tells you whether the component is hidden.

Remarks

See Using the Component Browser for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Select Defining Geometry (Workplane)

The Select Defining Geometry command allows you to see how a workplane is defined.

Details of Use

The faces or edges used in the definition of the workplane are highlighted. For constructed workplanes, such as 
mid-planes, this allows you to see how the workplane was constructed.

Remarks

See Using Constructed Workplanes for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Activate Sketch

The Activate Sketch command allows you to set the active sketch from the browser.

Details of Use

The sketch under the cursor is made the active sketch.

Remarks

The Activate Sketch command on the browser popup menu is usually the most convenient way to find and activate 
a sketch. For example, you can use the feature browser and expand a feature icon to see which sketches it uses, 
then active the sketch you want. 

You can also use the Sketches command to set the active sketch. See Managing Your Sketches for more 
information.

See Also

{button ,AL(`popupMenu')} Related commands



New Sketch (Popup)

The New Sketch command allows you to create a new sketch in the specified workplane.

Details of Use

A new sketch belonging to the workplane under the cursor in the browser is created and set as the active sketch 
ready for you to use it.

Remarks

The New Sketch command on the Workplane or Drawing menu can also be used to create a new sketch. See 
Introduction to Sketching for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Select Defining Geometry (Mating Condition)

The Select Defining Geometry command allows you to see how a mating condition is defined.

Details of Use

The faces or edges used to define the mating condition under the cursor are highlighted.

Remarks

See Creating Mating Conditions for more information.

See Also

{button ,AL(`popupMenu')} Related commands



Delete (Mating Condition)

The Delete command allows you to delete a mating condition.

Details of Use

There is no graphics representation of a mating condition. You can only see that the components are assembled 
correctly. So you cannot select a mating condition in the view in order to use the Delete command on the Edit 
menu. Instead, you must use the Delete command on the popup menu in the component browser.

Remarks

You can use the Select Defining Geometry command to see how a mating condition is defined, so that you can delete
the right one.

See Also

{button ,AL(`popupMenu')} Related commands
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Annotations

The Annotations command enters the mode for selecting dimensions, callouts, leaders, cross hatching, and other 
annotation objects. Callouts include textual notes, datum labels, geometric tolerances and dimension values.

Details of Use

In order to select annotations in the drawing, you must use the Annotations command to enter the annotation 
selection mode first. Then you will see that annotations are pre-highlighted as you move the cursor over them.

Remarks

See Selecting Objects for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Features

The Features command enters the mode for selecting drafting features.

Details of Use

In order to select features in the drawing, you must use the Features command to enter the drafting feature 
selection mode first. Then you will see that features are pre-highlighted as you move the cursor over them.

Remarks

See Selecting Objects and Introduction to Feature-Based Drafting for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Views

The Views command enters the mode for selecting drawing views.

Details of Use

In order to select views in the drawing, you must use the Views command to enter the drawing view selection 
mode first. Then you will see that drawing views are pre-highlighted as you move the cursor over them.

Remarks

See Selecting Objects and Introduction to Drawings for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Lines

The Lines command enters the mode for selecting lines.

Details of Use

In order to select lines in the active sketch, you must use the Lines command to enter the line selection mode first.
Then you will see that lines are pre-highlighted as you move the cursor over them.

Remarks

See Selecting Objects for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Workplanes

The Workplanes command enters the mode for selecting workplanes.

Details of Use

When you use the Workplanes command to enter the workplane selection mode, all the workplanes in your part are
displayed so that you can select them.

Remarks

See Selecting Objects for more information.

Many workplane commands are available on the popup menu in the workplane browser.

See Also

{button ,AL(`selectMenu')} Related commands



Edges

The Edges command enters the mode for selecting edges.

Details of Use

In order to select edges in the active sketch, you must use the Edges command to enter the edge selection mode 
first. Then you will see that edges are pre-highlighted as you move the cursor over them.

Remarks

See Selecting Objects for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Faces

The Faces command enters the mode for selecting faces.

Details of Use

In order to select faces in the active sketch, you must use the Faces command to enter the face selection mode 
first. Faces are selected by selecting an edge. The side of the edge you are on will determine which of the two 
possible faces is selected. 

Remarks

Selecting faces by selecting an edge, allows you to select faces at the back of your part without having to rotate 
the part first. See Selecting Objects for more information.

See Also

{button ,AL(`selectMenu')} Related commands



Parts

The Parts command enters the mode for selecting parts.

Details of Use

When in the mode for selecting parts, components can be selected. You can also select solids in order to select the 
part itself. In a multi-level assembly, leaf nodes – piece parts - are selected.

Remarks

See Selecting Objects for more information.

Having selected a piece part in an assembly, you can select its parent assembly by using the Parent of Selected Part 
command. To select an immediate component of your active part, you can use the Select Component command on 
the popup menu in the component browser.

See Also

{button ,AL(`selectMenu')} Related commands



Edges of Selected Faces

The Edges of Selected Faces command selects all edges that surround the selected faces.

Details of Use

After you have used the Edges of Selected Faces command, you are left in the selecting edges mode.

Remarks

You might use the Edges of Selected Faces command when you want to blend all edges around a face.

See Also

{button ,AL(`selectMenu')} Related commands



Parent of Selected Part

The Parent of Selected Part command selects the parent assembly of the selected component part.

Details of Use

Select a single part, then use the Parent of Selected Part command to select its parent instead.

Remarks

To select an immediate component of a your active part, you can use the Select Component command on the popup
menu in the component browser.

See Also

{button ,AL(`selectMenu')} Related commands



Add Connected Lines

The Add Connected Lines command add all other connected lines to the line selection.

Details of Use

All lines in the active sketch that are connected end-to-end are added to the selection of lines.

Remarks

The Add Connected Lines command makes it easy to select a line chain ready for offsetting with the Offset Chain 
command.

See Also

{button ,AL(`selectMenu')} Related commands



Add Tangent Edges

The Add Tangent Edges command adds edges to the selection that are smooth continuations of the selected edges.

Details of Use

All other edges that are smooth continuations of the currently selected edges, if any, are added to the edge 
selection.

Remarks

If you want to blend along a smooth chain of edges, you do not need to use Add Tangent Edges to select all the 
required edges, since there is an option in the Blend Edges Dialog for automatically propagating along tangent-
continuous edges.

See Also

{button ,AL(`selectMenu')} Related commands



Add Tangent Faces

The Add Tangent Faces command adds faces to the selection that are smooth continuations of the selected faces.

Details of Use

All other faces that are smooth continuations of the currently selected faces, if any, are added to the face selection.

Remarks

Selecting a blend face, then using Add Tangent Faces, will add the faces on each side of the blend to the selection.

See Also

{button ,AL(`selectMenu')} Related commands



Points from Edges

The Points from Edges command allows you to create lines using attraction points from edges.

Details of Use

The check mark next to the Points from Edges menu entry show you whether points are currently being taken from 
edges. If off, attraction points are selected from lines.

Remarks

Turn Points from Edges on in order to define section cut lines in a drawing so that they cut precisely through model 
geometry. Turn Points from Edges off again to add further lines to the line chain.

See Also

{button ,AL(`selectMenu')} Related commands



Remove Inactive Objects

The Remove Inactive Objects command removes objects belonging to the context part from the selection.

Details of Use

When a part is open in context, you can select edges and faces either in the active part, or in the context part. 
Using the Remove Inactive Objects command de-selects all the context part objects. 

Remarks

Many commands are disabled if faces or edges of the context part are selected. Use Remove Inactive Objects in such
situations in order to enable such commands. An example is Blend Edges.

See Also

{button ,AL(`selectMenu')} Related commands



Synchronize Browser

The Synchronize Browser command finds the icon in the browser that corresponds to the selected object.

Details of Use

You can select an edge or face in the view, then use the Synchronize Browser command to find the feature that 
produced that edges or face. As a short cut, you can double-click on the edge or face with the CTRL key held down.

Remarks

The Synchronize Browser command provides a quick way to access a feature in the browser by selecting an edge or
face in the view. Then you can use the feature browser to access the sketch used to generate the feature, and 
activate it ready to edit it.

See Also

{button ,AL(`selectMenu')} Related commands



This is before the first topic, so it will not get displayed

This file contains commands that the Workplane menu and the Drawing menu have in common. There isn’t a 
Sketch menu as such.



Reposition Axes

The Reposition Axes command allows you to change the location and orientation of the work axes.

Details of Use

Having chosen the Reposition Axes command, you should then click or drag the cursor in the active window. To 
change the location of the work axes origin, without changing the orientation, just click on the new origin. All the 
standard attraction points are available, such as end points, intersection points, and grid points. To change the 
orientation of the work axes, keep the mouse button down and drag to specify the new x-direction. 

To cancel the command without changing the work axes, you can press the ESCAPE key.

Remarks

In order to be able to return the work axes to a previous location and orientation, you should mark that location 
and orientation using some construction lines. The Toggle Construction command allows you to create construction 
lines.

You can use the Transform Axes command to translate or rotate the work axes by a specific amount. See Using the 
Work Axes for more information.

See Also

{button ,AL(`sketchMenu')} Related commands



Transform Axes

The Transform Axes command allows you to translate or rotate the work axes by a specific amount.

Details of Use

Choose the Translate or Rotate page in the dialog. The transformation is within the active workplane, according to 
the current work axes.

Remarks

In order to be able to return the work axes to a previous location and orientation, you should mark that location 
and orientation using some construction lines. The Toggle Construction command allows you to create construction 
lines.

You can also use the Reposition Axes command to change the location and orientation of the work axes. See Using 
the Work Axes for more information.

See Also

{button ,AL(`sketchMenu')} Related commands



New Sketch

The New Sketch command allows you to create a new sketch in a specific workplane.

Details of Use

If a workplane is selected, that workplane will be offered in the New Sketch Dialog as suggested workplane for the 
new sketch. Otherwise the active workplane is offered. In either case, you can change the workplane suggested.

Remarks

You can also create a sketch in a particular workplane, by choosing the New Sketch command on the popup menu 
for that workplane in the browser.

All the workplane creation commands create a sketch in that workplane ready to use.

See Managing Your Sketches for more information.

See Also

{button ,AL(`sketchMenu')} Related commands



Hide Other Sketches

The Hide Other Sketches command hides all sketches except for the active sketch.

Details of Use

To reduce visual clutter in your views, and to reduce the chance of inadvertantly selecting points from lines in other
sketches, you can hide other sketches using this command.

Remarks

You can also hide specific sketches using the Sketches command. 

See Managing Your Sketches for more information.

See Also

{button ,AL(`sketchMenu')} Related commands



Sketches

The Sketches command allows you to manage your sketches.

Details of Use

The dialog window allows you to hide and show sketches and change the active sketch.

Remarks

You can also use the workplane browser to manage your sketches. See Managing Your Sketches for more 
information.

See Also

{button ,AL(`sketchMenu')} Related commands



This is before the first topic, so it will not get displayed

Notes can go here. 



Components Browser

The Components Browser command allows you to show the component browser in the browser pane of the active 
part window.

Details of Use

The bullet in the Tools menu indicates which browser is currently shown. You can also use the drop list in the dialog
bar in the part window itself to change between browsers.

Remarks

If you have more than one window displaying the same part, you can show different browsers in each window. See 
Creating Additional Windows for more information.

See Using the Component Browser for more on the component browser.

See Also

{button ,AL(`toolsMenu')} Related commands



Features Browser

The Features Browser command allows you to show the feature browser in the browser pane of the active part 
window.

Details of Use

The bullet in the Tools menu indicates which browser is currently shown. You can also use the drop list in the dialog
bar in the part window itself to change between browsers.

Remarks

If you have more than one window displaying the same part, you can show different browsers in each window. See 
Creating Additional Windows for more information.

See About the Feature Browser for more on the feature browser.

See Also

{button ,AL(`toolsMenu')} Related commands



Workplanes Browser

The Workplanes Browser command allows you to show the workplane browser in the browser pane of the active 
part window.

Details of Use

The bullet in the Tools menu indicates which browser is currently shown. You can also use the drop list in the dialog
bar in the part window itself to change between browsers.

Remarks

If you have more than one window displaying the same part, you can show different browsers in each window. See 
Creating Additional Windows for more information.

See Using the Workplane Browser for more on the workplane browser.

See Also

{button ,AL(`toolsMenu')} Related commands



Main Toolbar

The Main Toolbar command allows you to hide and show the main toolbar.

Details of Use

The check mark next to the command indicates whether the main toolbar is currently shown.

Remarks

As well as hiding the main toolbar, you can also remove it from its “docked” position so that it is “floating”. Just 
drag the toolbar at some point on its background to make it floating. To return it to a docked position, you can 
either double-click on its titlebar, or drag it to one edge of the DesignWave application window.

See Also

{button ,AL(`toolsMenu')} Related commands



Modeling Toolbar

The Modeling Toolbar command allows you to hide and show the modeling toolbar for the active part window.

Details of Use

Each part window has its own modeling toolbar. The check mark next to the command indicates whether the 
modeling toolbar is currently shown.

Remarks

You might hide the modeling toolbar to increase the size of the graphical view. The Modeling Toolbar command 
allows you to show it again.

As well as hiding the modeling toolbar, you can also remove it from its “docked” position so that it is “floating”. Just
drag the toolbar at some point on its background to make it floating. To return it to a docked position, you can 
either double-click on its titlebar, or drag it to one edge of the DesignWave application window.

See Also

{button ,AL(`toolsMenu')} Related commands



Dialog Bar

The Dialog Bar command allows you to hide and show the dialog bar for the active part window.

Details of Use

Each part window has its own dialog bar. The check mark next to the command indicates whether the dialog bar is 
currently shown.

Remarks

You might hide the dialog bar to increase the size of the graphical view. The Dialog Bar command allows you to 
show it again.

As well as hiding the dialog bar, you can also remove it from its “docked” position so that it is “floating”. Just drag 
the dialog bar at some point on its background to make it floating. To return it to a docked position, you can either 
double-click on its titlebar, or drag it to one edge of the DesignWave application window.

See Also

{button ,AL(`toolsMenu')} Related commands



Status Bar

The Status Bar command allows you to hide and show the status bar.

Details of Use

The status bar lies along the bottom edge of the DesignWave application window. This is where prompts for menu 
commands are displayed.

Remarks

You might hide the status bar to increase the screen space remaining for your document windows. The Status Bar 
command allows you to show it again.

See Also

{button ,AL(`toolsMenu')} Related commands



Measure

The Measure command gives you measurement information for the selected object or pair of selected objects.

Details of Use

With nothing selected, you can use the Measure command to examine the list of recent measurements, or to add 
another value to the list. 

With a single edge, face, or line selected, the Measure command gives you measurement information about that 
object, such as its closest distance to the active workplane.

With two edges, faces, or lines selected, the Measure command gives you a measurement of their closest distance 
of separation.

Remarks

When you use the Measure command, values are added to the top of the list of recent measurements. You can then
access this list in many dialog windows, such as the Extrude Profile dialog. This allows you use a measurement as 
input to another command, without having to copy and paste the value.

See Also

{button ,AL(`toolsMenu')} Related commands



Options

The Options command allows you to choose various preference settings to take affect until further notice.

Details of Use

The settings are grouped into pages in the dialog window. Many pages have disabled controls. This is because the 
same pages are displayed when you use the Properties command to examine or modify the properties of an object,
and some of the controls are not available in the Options command.

Remarks

See Setting User Options for more information.

See Also

{button ,AL(`toolsMenu')} Related commands



This is before the first topic, so it will not get displayed
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Shaded

The Shaded command allows you to turn shading on or off for the active part window.

Details of Use

The check mark on the View menu next to the Shaded entry indicates whether shading is currently on. You can also
access the Shaded command using the check box on the dialog bar at the top of the part window.

The Shaded command is not affected by the Undo command. 

Remarks

Working with shading on helps you to understand the solid nature of your part. It is slightly faster to work with 
shading turned off. See Creating Additional Windows for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Admire

The Admire command allows you to turn admire mode on or off for the active part window.

Details of Use

The check mark on the View menu next to the Admire entry indicates whether admire mode is currently on. You can
also access the Admire command using the check box on the dialog bar at the top of the part window.

The Admire command is not affected by the Undo command.

Remarks

In admire mode, lines are removed from the view. If the view is also shaded, edges are removed so you can see 
the shading on its own. You cannot select objects in a view that has admire mode turned on. See Creating 
Additional Windows for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Autoscale

The Autoscale command fits the scene to the window, so that you can see all of it.

Details of Use

For a part, the solids and components in the model are autoscaled to the window.    If the part is empty, the scene 
is autoscaled so that you can see the three initial workplanes.    

For a drawing, the paper area of the sheet is made to fit the window.    Any lines, annotation, or drawing views 
placed outside the sheet are ignored.

For a part window that has been split into several planes using the Split command, the behavior of the Autoscale 
command on the Windows menu is to autoscale all panes.    But the behavior of the Autoscale command on the 
popup menu inside the window is to autoscale the pane you are in, plus any other panes that are in a fixed 
relationship with it.    

For example, if the window is split into four panes, and you Autoscale the bottom right pane, the other three will be
unaffected.    If you Autoscale one of the other three panes, the two related panes will also be autoscaled, but the 
bottom right pane will be unaffected.

Remarks

Autoscale is one of the viewing commands. See Using Viewing Commands and Splitting a Part Window for more 
information.

See Also

{button ,AL(`viewMenu')} Related commands



Half Scale

The Half Scale command zooms out on the scene in the window by a factor of two.    

Details of Use

For a part window that has been split into several planes using the Split command, the behaviour of the Half Scale 
command on the Windows menu is to zoom out for all panes.    But the behaviour of the Half Scale command on the
popup menu inside the window is to zoom out the pane you are in, plus any other panes that are in a fixed 
relationship with it.    

For example, if the window is split into four panes, and you Half Scale the bottom right pane, the other three will be
unaffected.    If you Half Scale one of the other three panes, the two related panes will also be zoomed out, but the 
bottom right pane will be unaffected.

Remarks

See Using Viewing Commands and About the User Interface for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Zoom In

The Zoom In command allows you to zoom in on a chosen area of the scene within the window.

Details of Use

To perform the zoom, place the cursor at the center of the area of interest, press the left mouse button down, and 
drag the cursor.    The dynamic box displayed shows you the precise scene that will fill the window when you 
release the mouse button.    To cancel a zoom while you are dragging, hit the ESCAPE key, then try again.    To 
cancel the zoom mode, hit the ESCAPE key another time.

Remarks

See Using Viewing Commands and About the User Interface for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Pan

The Pan command allows you to move the scene within the window.

Details of Use

To perform the pan, press the left mouse button down in the view and drag the cursor.    The dynamic line drawn 
shows you the shift that will be applied to the scene when you release the mouse button.    To cancel a pan while 
you are dragging, hit the ESCAPE key, then try again.    To cancel the pan interface mode, hit the ESCAPE key 
another time.

Remarks

See Using Viewing Commands and About the User Interface for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Trimetric

The Trimetric command rotates the view to show you a trimetric projection.

Details of Use

If the part window has been split, the Trimetric command only affects the main view. 

Remarks

A trimetric projection shows your part such that each of the principle directions – up, front, and right – are at a 
different angle to the view plane. This tends to avoid front edges obscuring back edges, and front corners being 
superimposed on back corners.

See Also

{button ,AL(`viewMenu')} Related commands



Isometric

The Isometric command rotates the view to show you an isometric projection.

Details of Use

If the part window has been split, the Isometric command only affects the main view. 

Remarks

An isometric projection shows your part such that each of the principle directions – up, front, and right – are at the 
same angle to the view plane. This means that you can visually compare distances along the principle directions.

See Also

{button ,AL(`viewMenu')} Related commands



Plan

The Plan command rotates your view to show you a plan view.

Details of Use

If the part window has been split, the Plan command only affects the main view. 

Remarks

A plan view is the same as a view onto the “base” workplane. You can also see a plan view if you split your part 
window. See Splitting a Part Window for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Front Elevation

The Front Elevation command rotates your view to show you a front elevation.

Details of Use

If the part window has been split, the Front Elevation command only affects the main view. 

Remarks

A front elevation is the same as a view onto the “frontal” workplane. You can also see a front elevation if you split 
your part window. See Splitting a Part Window for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Right Elevation

The Right Elevation command rotates your view to show you a right elevation.

Details of Use

If the part window has been split, the Right Elevation command only affects the main view. 

Remarks

A right elevation is the same as a view onto the “lateral” workplane. You can also see a right elevation if you split 
your part window. See Splitting a Part Window for more information.

See Also

{button ,AL(`viewMenu')} Related commands



Onto Workplane

The Onto Workplane command rotates your view so that you are looking flat onto the active workplane.

Details of Use

If the part window has been split, the Onto Workplane command only affects the main view. 

Remarks

Although you are not required to do so, you may find it more convenient to sketch in a view that shows the 
workplane flat-on. This often makes selecting points easier, especially grid points.

See Also

{button ,AL(`viewMenu')} Related commands



Spin, Tilt and Turn

The rotation commands – Spin Left, Spin Right, Tilt Up, Tilt Down, Turn Anticlockwise, and Turn Clockwise – allow you 
to rotate your view to change its view direction.

Details of Use

Although you can access these commands on the View menu, it is more convenient to use the keyboard 
accelerators which are the arrow keys, and the Page Up and Page Down keys.

These commands rotate the view in 5 degree increments.

Remarks

You can rotate your view at any time. Note that sketching commands that involve selecting points in the workplane
will not work if the workplane is within 15 degrees of side-on.

See Also

{button ,AL(`viewMenu')} Related commands



Tumble

The Tumble command spins your view around in all sorts of directions so you can admire it.

Details of Use

While the view is tumbling, it is displayed in admire mode. You cannot work in the view until you cancel the tumble 
mode. To stop the tumble, just press any key. If you press the ENTER key, the view direction at that time is kept. 
Pressing any other key returns the view to the view direction it had before you used the Tumble command.

Remarks

You can use the Tumble command to get a better visual appreciation for the solid form of the part, or just for fun.

See Also

{button ,AL(`viewMenu')} Related commands
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New Window

The New Window command allows you to create another window displaying the same subject as the active window.

Details of Use

The new window created will initially be the same as the original window, but afterwards, you can use viewing 
commands so as to see the subject differently in the new window.

Remarks

You can have any number of additional windows for the subject. See Creating Additional Windows for why you 
might want to work with multiple windows of the same subject. To close an additional window, use the Close button
on the window itself.

See Also

{button ,AL(`windowMenu')} Related commands



Split

The Split command breaks up the viewing area of a part window to produce additional panes.

Details of Use

A special cursor appears so that you can choose where you want the split to be. By placing the cross left, right, 
above, or below the window, you can split the window into two panes. Otherwise you will get four panes. To cancel 
the command instead, you can press the ESCAPE key.

Remarks

See Splitting a Part Window for a discussion of this facility.

See Also

{button ,AL(`windowMenu')} Related commands



Cascade

The Cascade command allows you to find windows more easily.

Details of Use

All windows that are not minimized are arranged in an overlapping fashion to that the title bar of each window can 
easily be seen.

Remarks

You can also use the Tile command to arrange windows so that they do not overlap.

See Also

{button ,AL(`windowMenu')} Related commands



Tile

The Tile command arranges your part and drawing windows so you can see them all.

Details of Use

All windows that are not minimized are arranged in a non-overlapping fashion so that they tile all of the area 
available in the DesignWave application window.

Remarks

You can also use the Cascade command to arrange windows in an overlapping fashion.

See Also

{button ,AL(`windowMenu')} Related commands



Arrange Minimized

The Arrange Minimized command arranges your minimized windows so you can see them all.

Details of Use

Your minimized part and drawing windows are arranged in neat rows along the bottom of the DesignWave 
application window.

Remarks

You might want to use Arrange Minimized if you have just resized the DesignWave application window and your 
minimized windows can no longer be seen.

See Also

{button ,AL(`windowMenu')} Related commands



Windows 1, 2, 3, ...

Use this command to find a window.

Details of Use

At the end of the Window menu, all of your part and drawing windows are listed.    You can choose one of these 
menu entries to bring that window to the front and activate it.

Remarks

You can work with multiple windows displaying the same part or drawing. See Creating Additional Windows for 
more information.

See Also

{button ,AL(`windowMenu')} Related commands
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Plane of Object

The Plane of Object command allows you to create a workplane in the natural plane of the selected object.

Details of Use

You must select an edge or face that has a natural plane. You can select a planar face, a toroidal face, a circular 
edge, or an elliptical edge. If you select a planar face, the workplane will face outwards from the model.

The workplane is created containing a single sketch which is set as your active sketch, ready for you to start 
sketching.

Remarks

Use the Plane of Object command to start sketching on a planar face.

See Also

{button ,AL(`workplaneMenu')} Related commands



Plane Through Objects

The Plane Through Objects command allows you to create a workplane that passes through the two selected 
objects.

Details of Use

You must select two faces or edges through which a plane can be constructed. You can select two cylindrical or 
conical faces to construct a plane through their axes, or two straight co-planar edges.

Remarks

See Using Constructed Workplanes for more information.

See Also

{button ,AL(`workplaneMenu')} Related commands



Mid-Plane (Workplane)

The Mid-Plane command allows you to create a workplane that is the mid-plane of the two selected objects.

Details of Use

You must select two planar faces, or two existing workplanes, then choose the Mid-Plane command.

Remarks

See Using Constructed Workplanes for more information.

See Also

{button ,AL(`workplaneMenu')} Related commands



Offset Plane

The Offset Plane command allows you to create a workplane that is offset from the selected workplane or face.

Details of Use

You must select an exising workplane, or a planar face. The dialog window allows you to enter the offset. The 
positive direction of the offset is above the existing workplane, or outwards from the planar face.

Remarks

See Using Constructed Workplanes for more information.

See Also

{button ,AL(`workplaneMenu')} Related commands



Oriented Plane

The Oriented Plane command allows you to create a workplane angled through the selected face or edge.

Details of Use

You must select a face or edge with a natural axis, or a straight edge. The axis must lie parallel to the active 
workplane. The dialog window allows you to enter the angle or rotation from the active workplane. The positive 
direction of the angle is so as to move the x-direction of the work axes upwards. If the x-direction is parallel to the 
selected edge, the angle is so as to move the y-direction upwards.

Remarks

If the workplane rotates the opposite direction from what you expected, use the Undo command, and try again 
with the negative angle.

See Using Constructed Workplanes for more information.

See Also

{button ,AL(`workplaneMenu')} Related commands



Reverse

The Reverse command reverses the workplane by mirroring the work axes.

Details of Use

The work axes are mirrored in the y-direction so as to reverse the workplane, swapping the meaning of above and 
below.

Remarks

If you are looking at the top of the workplane, you will notice that the work axes arrowheads are shown solid. If 
you are looking at the bottom, you will see them in outline only.

Reversing the workplane does not affect anything you did earlier that used the above-below sense of the 
workplane.

See Also

{button ,AL(`workplaneMenu')} Related commands
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Not sure which messages we should elaborate on. The message box itself is usually 
pretty useful in most cases. For starters, just include the more serious or frequent 
errors that might confuse the poor user.

I am plucking the help IDs from dSpaceAlias.txt which I then move to the bottom and 
comment out.

<end>



Drawing Views – Invalid Section Cuts

The section definition sketch is invalid. This situation can occur when you use the Add Section View command. The 
section definition sketch must contain a chain of connected straight lines that is not closed.

Course of Action

You might try one or more of the following:

Make sure you have specified the correct sketch for the section definition.
Join up any gaps in the section cut lines.
Join any stepped section cuts with construction lines.
Delete any stray lines that may have invalidated the section line.

See Fixing Sketches for related information.

Remarks

When you are connecting end-to-end lines for a section definition, make sure the Edges check box is turned off in 
order to select the end-points of the lines in the sketch, otherwise you may leave small gaps between the lines. 
Use the Edges option only when you need to pick up attraction points of features within the model.

Another common cause for an invalid section line results from creating the lines in an existing sketch used for 
another purpose. Similarly, you can invalidate an existing section definition sketch by accidentally adding lines 
which are supposed to be part of another sketch. To highlight all the lines contained in a sketch, choose the Select 
Lines command and then choose Select All on the Edit menu.

See About Section Views for more about section views and defining section cuts.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Drawing Views – Invalid Section Direction

The section definition sketch does not define the principle section and viewing direction. This situation can occur 
when you use the Add Section View command. The line chain must have a straight construction line at one end that
indicates the direction away from the eye.

Course of Action

You might try one or more of the following:

Add a construction line indicating the principal section line.
Determine if there is a gap between the construction line and section line and join up if necessary.
Delete any stray lines that may have invalidated the profile.

See Fixing Sketches for related information.

Remarks

A common cause for an invalid section line results from creating the lines in an existing sketch used for another 
purpose. Similarly, you can invalidate an existing section definition sketch by accidentally adding lines which are 
supposed to be part of another sketch. To highlight all the lines contained in a sketch, choose the Select Lines 
command and then choose Select All on the Edit menu.

See About Section Views for more about section views and defining section cuts.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Drawing Views – Invalid Clipping Profile

The profile specified for clipping a view is invalid. The sketch must contain a closed polygon made of straight lines 
only. Construction lines are ignored.

Course of Action

You might try one or more of the following:

Close an open profile.
Trim portions of the intersecting lines so that they now form a closed loop.
Delete any stray lines that may have invalidated the profile.
Replace any curves with an approximation formed of straight segments.

See Fixing Sketches for related information.

Remarks

A common cause for an invalid profile results from creating the profile in an existing sketch containing other lines. 
Similarly, you can invalidate an existing sketch used as a profile by accidentally adding lines which are supposed to 
be part of another sketch. To highlight all the lines contained in a sketch, choose the Select Lines command and 
then choose Select All on the Edit menu.

See Clipping Views for more about partial views and clipping profiles.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Tolerancing - Invalid Datum

The geometric tolerance uses an invalid datum. This situation can arise when the datum refers to geometry that is 
neither planar nor axial. It is not possible to use such geometry in a datum reference frame.

Course of Action

You should select another datum or re-create the existing datum so that it references a planar or axial feature.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Tolerancing - Duplicate Datum

The datum reference frame that is used for a geometric tolerance contains duplicate datums.

Course of Action

You should rename one of the datums.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Tolerancing - Invalid Common Datum

A common datum used in a geometric tolerance is invalid. This situation can arise if the two features specified by 
the reference datum and common datum do not have the same geometry.

Course of Action

Select a common datum that has a plane or axis aligned with the reference datum.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Tolerancing - Invalid Datum Reference Frame

The datum reference frame that the geometric tolerance uses is invalid. Each member of the datum reference 
frame must contribute at least one constraint otherwise it is redundant. 

Course of Action

Select a different set of datums for the reference frame or re-define the datums to use different geometry.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages



Tolerancing - Invalid Datum Count

The geometric tolerance requires a datum reference frame but an invalid number of datums have been selected for 
this type.

Course of Action

Make sure that you have selected datums for all the enabled fields in the Tolerance dialog.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages 



Tolerancing - Invalid Datum Geometry

The geometric tolerance demands a different geometry type for the datum specified. An example of where this 
situation can arise is when a tolerance requires a datum that references axial geometry, but the datum's geometry 
is planar. For a cylindrical run-out tolerance, the feature being controlled and its datum must reference geometry 
with a common axis.

Course of Action

Select a different datum or re-define one or more of the datums to refer to the correct geometry type for the 
tolerance.

Remarks

For total run-outs using non-cylindrical features, you may need to create an axis. This axis must be a common 
reference for the datum and the tolerance. You can create the axis by using a combination of the center-line tools, 
such as Mid-Plane and Phantom Intersection. See Using Center Lines and Center Points for more details.

For more information on tolerancing, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature 
Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages 



Tolerancing - Invalid Datum Orientation

The relative orientation of the feature being toleranced and the datum is invalid for the tolerance type. This 
situation can arise, for example, if a perpendicularity tolerance is selected for feature when the datum is parallel.

Course of Action

Select a different datum or re-define one or more of the datums to refer to correctly oriented geometry for the 
tolerance.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages 



Tolerancing - Invalid Feature Geometry

The feature geometry is inappropriate for the tolerance type.

Course of Action

Select a different tolerance type or reposition the geometric tolerance on a different feature.

Remarks

For more information, see Feature-Based Tolerancing, Adding Datum Labels and Adding Feature Control Symbols.

See Also

{button ,AL(`draftingMessages')}Other drafting messages 
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Extruded Profile – Invalid Profile

The lines in the sketch you are trying to extrude do not form a valid profile. This means that not all the loops in the
sketch are closed or you may have some intersecting lines in the sketch. You may also have some nested inner 
loops.

Course of Action

You might try one or more of the following:

Close the open loops in the sketch.
Trim portions of the intersecting lines so that they now form a closed loop.
Delete stray lines if any that may have invalidated the profile.
Delete inner loops that are inside another inner loop. Make sure inner loops are not touching the outer 

loops or are coincident with some lines in the outer loops.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the profile. 

See Fixing Sketches for related information.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used. The 
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Creating the Basic Shape and Adding Bosses, Pads and Pockets for more about extruding profiles. See About 
Profiles for more information about validity of profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Extruded Profile - Invalid Taper

The taper angle was too large for the extrusion distance.    This means that the side walls of the extrusion would 
meet or clash, which is not permitted.

Course of Action

You might try one or more of the following:

Reduce the taper angle so that the side walls taper less sharply.
Reduce the extrusion distance.
Modify the profile to make it broader in the suspected problem region.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Properties command 
on the feature browser popup menu to fix it, or use the Undo command to remove it.    In some cases after a 
feature failure, the Undo command is not available, and you must use the Condemn command on the browser 
popup menu instead.

See Creating the Basic Shape and Adding Bosses, Pads and Pockets for more about extruding profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Impossible Case

You are trying to blend two edges at a corner having three edges.

Course of Action

You might try one or more of the following:

Blend the third edge too.
Blend just one edge out of the three edges at the corner.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used. The 
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it.    In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Edges Deleted

The edges that you blended have been deleted.

Course of Action

You might try one or more of the following:

Suppress the feature.
Condemn the feature.

Remarks

This situation can occur when the Update Design command is used. The feature is shown in the feature browser 
with a  mark against it to indicate that it has a problem.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Could Not Apply

DesignWave could not blend the edges you selected.

Course of Action

You might try one or more of the following:

Deselect any smooth edges and blend again.
Blend edges one at a time if you were blending a number of edges together.
Report the problem to DesignWave customer support.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it.    In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Inconsistent Radius

The radius of the blend is inconsistent with the blend radius of an adjacent edge.

Course of Action

You might try one or more of the following:

Deselect any smooth edges and blend again.
Blend adjacent edges with same radius.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it or use the Properties command on the feature browser popup menu to change the radius of the blend.    
In some cases after a feature failure, the Undo command is not available, and you must use the Condemn 
command on the browser popup menu instead.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Radius Too Large

The blend radius you specified is too large.

Course of Action

You might try one or more of the following:

Reduce blend radius.
Make the part broader in the suspected problem region.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point. So you need to use the Undo command to 
remove it or use the Properties command on the feature browser popup menu to change the radius of the blend.    
In some cases after a feature failure, the Undo command is not available, and you must use the Condemn 
command on the browser popup menu instead.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Blend – Corner Too Complex

You are trying to blend the edges at a corner having four or more edges. 

Course of Action

You might try one or more of the following:

Blend the edges one at a time.
Blend edges having the same convexity together.
Change the order in which you are blending the edges at the complex corner.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it.    In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Adding Blends, Fillets, and Chamfers for more about blending edges.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Hollow – Body Would Split

The solid you are trying to hollow would split into multiple solids.

Course of Action

You might try one or more of the following:

Reduce the wall offset distance.
Flatten sharp corners and turns in the part.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point. So you need to use the Undo command to 
remove it or use the Properties command on the feature browser popup menu to change the offset of the hollow.    
In some cases after a feature failure, the Undo command is not available, and you must use the Condemn 
command on the browser popup menu instead.

See Creating Thin Walled Parts for more about creating hollow features.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Hollow – Faces Deleted

The faces that you selected for removal have been deleted.

Course of Action

You might try one or more of the following:

Suppress the feature.
Condemn the feature.

Remarks

This situation can occur when the Update Design command is used. The feature is shown in the feature browser 
with a  mark against it to indicate that it has a problem.

See Creating Thin Walled Parts for more about creating hollow features.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Hollow – Could Not Apply

DesignWave could not create the thin walled solid.

Course of Action

You might try one or more of the following:

Reduce the wall offset distance.
Select all smoothly connected faces to remove, if you had selected only some of them.
Do blend operations after hollow.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point. So you need to use the Undo command to 
remove it or use the Properties command on the feature browser popup menu to change the offset of the hollow.    
In some cases after a feature failure, the Undo command is not available, and you must use the Condemn 
command on the browser popup menu instead.

See Creating Thin Walled Parts for more about creating hollow features.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Projected Profile – Unsuitable Position

The position of the sketch is such that it cannot be projected onto the part.

Course of Action

You might try one or more of the following:

Reposition the sketch on the workplane.
Change the projection direction.
Move the sketch onto a different workplane.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Projecting Profiles onto Your Model and Adding Holes for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Projected Profile – Invalid Profile

The lines in the sketch you are trying to project do not form a valid profile. This means that not all the loops in the 
sketch are closed or you may have some intersecting lines in the sketch. You may also have some nested inner 
loops.

Course of Action

You might try one or more of the following:

Close the open loops in the sketch.
Trim portions of the intersecting lines so that they form a closed loop.
Delete stray lines if any that may have invalidated the profile.
Delete inner loops that are inside another inner loop. Make sure inner loops are not touching the outer 

loops or are coincident with some lines in the outer loops.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the profile. 

See Fixing Sketches for related information.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Projecting Profiles onto Your Model and Adding Holes for more information. See About Profiles for more 
information about validity of profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Projected Profile – Misses Target Part

The position of the profile is such that the projected profile completely misses the target part.

You might try one or more of the following:

Reposition the sketch.
Modify the profile to make it broader.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Projecting Profiles onto Your Model and Adding Holes for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Projected Profile – Could Not Apply

DesignWave cannot project the profile you have sketched onto your part.

Course of Action

You might try one or more of the following:

Reposition the sketch.
Reduce the size of the sketch. Make sure that the profile is not larger all around than the face it sits on.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Projecting Profiles onto Your Model and Adding Holes for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Projected Profile – No Suitable Regions

The profile you have drawn cannot be projected because there is no suitable volume to add to the part or remove 
from the part.

Course of Action

You might try one or more of the following:

Reposition the profile.
Change the type of operation. Make sure that the part extends underneath the profile when you are 

adding material.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the sketch for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Projecting Profiles onto Your Model and Adding Holes for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Revolved Profile – Could Not Apply

The profile you have drawn cannot be revolved around the axis you have sketched because it may lead to self-
intersecting surfaces in the part.

Course of Action

You might try one or more of the following:

Reposition the axis of revolution. The axis line should not intersect any portion of the profile. It may be 
tangent to or coincident with lines in the profile, but it should not intersect the lines the profile.

Reposition the profile or change the shape of the profile.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the axis sketch or profile 
sketch for the feature, or change the relative position between the profile and the axis, or use the Undo command 
to remove the feature. In some cases after a feature failure, the Undo command is not available, and you must use
the Condemn command on the browser popup menu instead.

See Adding Revolved Features for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Revolved Profile – Invalid Axis Sketch

The sketch defining the axis of revolution is invalid. You may have more than one non-construction straight lines in 
the sketch.

Course of Action

You might try one or more of the following:

Remove non-straight line segments from the sketch.
Remove all the straight segments but one from the sketch.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the axis. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the axis sketch for the 
feature or use the Undo command to remove the feature. In some cases after a feature failure, the Undo command
is not available, and you must use the Condemn command on the browser popup menu instead.

See Adding Revolved Features for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Revolved Profile – Invalid Profile

The lines in the sketch you are trying to revolve do not form a valid profile. This means that not all the loops in the 
sketch are closed or you may have some intersecting lines in the sketch. You may also have some nested inner 
loops.

Course of Action

You might try one or more of the following:

Close the open loops in the sketch.
Trim portions of the intersecting lines so that they form a closed loop.
Delete stray lines if any that may have invalidated the profile.
Delete inner loops that are inside another inner loop. Make sure inner loops are not touching the outer 

loops or are coincident with some lines in the outer loops.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the profile. 

See Fixing Sketches for related information.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the profile for the feature, 
or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, 
and you must use the Condemn command on the browser popup menu instead.

See Adding Revolved Features for more information. See About Profiles for more information about validity of 
profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Swept Profile – Could Not Apply

DesignWave could not perform the sweep operation. You may have the sweep path such that the profile has to turn
corners too tightly which may lead to self-intersecting surfaces in the solid.

Course of Action

You might try one or more of the following:

Change the relative orientation of sweep path segments.
Reduce the size of the profile.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the path, or use the Undo 
command to remove it. In some cases after a feature failure, the Undo command is not available, and you must 
use the Condemn command on the browser popup menu instead.

See Creating Pipes, Grooves, and Lips for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Swept Profile – Invalid Corner

The sweep path that you have drawn contains a corner that cannot be constructed. The path segments at a corner 
may be tangentially connected. If the segments are not tangential, their curvatures should be same and they 
should curve in the same direction.

Course of Action

You might try one or more of the following:

Construct smooth (tangentially connected) path segments at the corner in question.
Create equal curvature for the path segments.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the path. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the path, or use the Undo 
command to remove it. In some cases after a feature failure, the Undo command is not available, and you must 
use the Condemn command on the browser popup menu instead.

See Creating Pipes, Grooves, and Lips for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Swept Profile – Invalid Orientation

The orientation of the path is inappropriate for the profile you are trying to sweep.    The path must intersect the 
plane of the profile perpendicularly.

Course of Action

You might try one or more of the following:

Change the orientation of the path such that it intersects the profile plane perpendicularly.
Tilt the profile plane such that the path intersects the profile plane perpendicularly.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix it, or the cause has been removed. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the path or the sketch of 
the profile, or use the Undo command to remove it. In some cases after a feature failure, the Undo command is not
available, and you must use the Condemn command on the browser popup menu instead.

See Creating Pipes, Grooves, and Lips for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Swept Profile – Invalid Path

The lines in the sketch that you have drawn for the path of the sweep do not form a valid path. There must be a 
single connected chain of lines.    You may have an open loop or a closed loop in the chain.    Construction lines are 
ignored.

Course of Action

You might try one or more of the following:

Delete stray lines from the sketch that may be invalidating the sketch for the path.
Delete all the loops in the sketch but one.
Trim the lines in the sketch to form one single open or closed loop.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the path. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the path of the sweep, or 
use the Undo command to remove it. In some cases after a feature failure, the Undo command is not available, and
you must use the Condemn command on the browser popup menu instead.

See Creating Pipes, Grooves, and Lips for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Swept Profile – Invalid Profile

The lines in the sketch you are trying to sweep do not form a valid profile. This means that not all the loops in the 
sketch are closed or you may have some intersecting lines in the sketch. You may also have some nested inner 
loops.

Course of Action

You might try one or more of the following:

Close the open loops in the sketch.
Trim portions of the intersecting lines so that they form a closed loop.
Delete stray lines if any that may have invalidated the profile.
Delete inner loops that are inside another inner loop. Make sure inner loops are not touching the outer 

loops or are coincident with some lines in the outer loops.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the profile. 

See Fixing Sketches for related information.

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to fix the profile, or use the Undo 
command to remove it. In some cases after a feature failure, the Undo command is not available, and you must 
use the Condemn command on the browser popup menu instead.

See Creating Pipes, Grooves, and Lips for more information. See About Profiles for more information about validity 
of profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Condemn – Dependent Features Condemned

When you condemn a feature in the tree, this message tells you how many dependent operations are condemned 
as a result.

Course of Action

You might try one or more of the following:

You can use Uncondemn All to undo the condemn operation.
You can Undo the condemn operation and edit the dependent operations such that they are no longer 

dependent on the condemned feature.
Acknowledge the message by pressing OK.

Remarks

This situation will happen whenever you condemn features that produce edges or faces referenced by other 
features. 

See Condemning Features for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Update Design – Update Now?

You will be prompted with this message whenever you re-order a feature.

Course of Action

You might try one or more of the following:

Re-order some more features after pressing No.
Update the part by pressing Yes.

Remarks

Some features may fail because of regenerating the model. You need to use the Undo command to undo the last 
re-order. 

See Updating Your Model    and Re-Ordering Features for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Feature – Name Already Exists

A feature already exists with the name that you have chosen for this feature.

Course of Action

You might try one or more of the following:

Use another name.
Accept the name supplied by DesignWave.

Remarks

This situation can occur when a feature name is edited from the property sheet or during creation.

See Introduction to Feature Modeling for more information on feature names.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Feature – No Target For Intersection

There is no solid in the part to perform the intersection operation with.

Course of Action

You might try one or more of the following:

Reorder the feature after creating some solid.
Uncondemn or unsuppress the features prior to this feature so that there is some solid to intersect with.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the problem. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it. In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Re-Ordering Features for more information on re-ordering features.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Feature – No Target For Subtraction

There is no solid in the part to subtract from.

Course of Action

You might try one or more of the following:

Reorder the feature after creating some solid.
Uncondemn or unsuppress the features prior to this feature so that there is some solid to subtract from.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready fix the problem. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it. In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Re-Ordering Features for more information on re-ordering features.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Feature – Invalid Result

The feature would produce an invalid solid. The invalidity may be because of three or more faces meeting at an 
edge.

Course of Action

You might try one or more of the following:

For a profile-based feature, reposition the sketch of the profile.
Increase or reduce the size of the profile

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready fix the problem. 

Remarks

This situation can occur when a feature is first created, or later on when the Update Design command is used.    The
feature is shown in the feature browser with a  mark against it to indicate that it has a problem.

If you just created the feature, note that it still exists at this point.    So you need to use the Undo command to 
remove it. In some cases after a feature failure, the Undo command is not available, and you must use the 
Condemn command on the browser popup menu instead.

See Modifying Profiles for more information on how to modify profiles.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Feature – Dormant Objects

The feature depends on faces or edges of the part that do not exist anymore. This means that some other feature 
prior to this feature that was responsible for generating these edges or faces has been condemned or suppressed. 
You can also create dormant objects by deleting some portions of the sketches of a profile and updating the model.

Course of Action

You might try one or more of the following:

Unsuppress features from the browser that might have generated the edges and faces that are dormant 
now.

Uncondemn features from the browser that might have generated the edges and faces that are dormant 
now.

Edit the sketches of features that might have generated the now dormant edges and faces.

Alternatively, you could use the Suppress command on the feature tree popup menu to take the feature out of 
service until you are ready to fix the problem. 

Remarks

This situation can occur when the Update Design command is used.    The feature is shown in the feature browser 
with a  mark against it to indicate that it has a problem. You may use the Condemn command on the browser 
popup menu to remove the feature from the tree altogether.

See About Dormant Faces and Edges for more information on dormant faces and edges. Also see Suppressing 
Features Within a Profile for more information on how to suppress a feature within a profile.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages
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Invalid Workplane

The planar definition of the workplane is invalid. This situation can occur when you use the Update Design 
command.

Course of Action

The workplane that failed is shown in the browser with a  mark against it to indicate that it has a problem. You 
can use the Explain Problem command on the popup menu to get more information.

You might try one or more of the following:
If you know the situation is temporary, you could ignore the problem. The workplane continues to exist 

with its “last good” position and will update as soon as it becomes valid again.
Instead of fixing the workplane, you could move all the sketches in the workplane to a new workplane and

then delete the old one. See Moving a Sketch to a Different Workplane for details.

Remarks

When you use the Update Design command, workplanes that depend on faces or edges in the part are updated 
automatically as soon as those faces and edges are updated. If a workplane cannot update properly, the design 
update stops so you can examine the problem.

See Using Constructed Workplanes for more information on workplanes.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages



Dormant Workplane

Faces or edges that are used to define the workplane are currently dormant. This situation can occur when you use
the Update Design command.

Course of Action

The workplane is shown in the feature browser with a  mark against it to indicate that it has a problem. You 
might try one or more of the following:

If you know the situation is temporary, you could ignore the problem. The workplane continues to exist 
with its “last good” position and will update as soon as the faces and edges it needs are no longer dormant.

In some cases, the situation might be permanent. For example, if you have a profile sketch and you have 
changed a firm line into a construction line, the face that was generated from that line will now be dormant, since 
you might change the line back again. See Suppressing Features Within a Profile for more information. But if you 
never have any intention of changing the line back again, that face is as good as deleted. In that case, you could 
move all the sketches in the workplane to a new workplane and then delete the old one. See Moving a Sketch to a 
Different Workplane for details.

Remarks

When you use the Update Design command, workplanes that depend on faces or edges in the part are updated 
automatically as soon as those faces and edges are updated. The design update does not stop just because a 
workplane depends on a face or edge that has become dormant. But if a feature is about to be updated and that 
feature depends on such a workplane, you are asked whether you want to stop, or whether you want to proceed 
regardless.

See About Dormant Faces and Edges for more information.

See Also
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Failed to Update Workplanes or Mating Conditions

During design update, some workplanes or mating conditions were updated and became invalid.

Course of Action

Any workplane or mating condition that failed is shown in the browser with a  mark against it to indicate that it 
has a problem. You can use the Explain Problem command on the popup menu to get more information.

Remarks

When you use the Update Design command, workplanes and mating conditions that depend on faces or edges in 
the part are updated automatically as soon as those faces and edges are updated. If a workplane or mating 
condition cannot update properly, the design update stops so you can examine the problem. 

See Using Constructed Workplanes and Creating Mating Conditions for more information.

See Also

{button ,AL(`featureMessages')} Other feature modeling messages
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No Help Available

No help is available for this command.

See Using Context-Sensitive Help for related information.



No Help Available

No help is available for this dialog window.

See Using Context-Sensitive Help for related information.



No Help Available

No help is available for this message window.

See Using Context-Sensitive Help for related information.



No Help Available

No help is available for this item of the user interface.

See Using Context-Sensitive Help for related information.
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Window Controls

You can access the window controls menu by pressing the left mouse button down over the icon at the far left side 
of the title bar of a window.    For the DesignWave application window, you can also use the right mouse button at 
any point along the title bar to access the same menu, or you can press ALT-SPACEBAR.

Restore

You can use the Restore command to return a window to the position and size it had before the Minimize command 
or Maximize command was used.    You can also restore a maximized window by double-clicking on its title bar, or 
by clicking on the middle of the three icons at the right hand end of the title bar.

Move

The Move command allows you to reposition a window using the keyboard.    You are presented with a four-headed 
arrow cursor to indicate that you can now use the arrow keys to move the window.    To make finer movements, 
you can hold the CTRL key down while you press the arrow keys.    To cancel the command, hit the ESCAPE key.    
To accept the new position, press the ENTER key.    The Move command is unavailable if the window is maximised.

Size

The Size command allows you to change the window size using the keyboard.    You are presented with a four-
headed arrow cursor to indicate that you can now use the arrow keys.    First press one of the arrow keys to jump 
the cursor to the edge of the window you want to adjust.    Optionally, you can then press a perpendicular arrow 
key to jump to a corner.    Then you can continue to press arrow keys to make the size adjustment you want.    To 
cancel the command, hit the ESCAPE key.    To accept the new size, press the ENTER key.    The Size command is 
unavailable if the window is maximised.

Minimize

You can use the Minimize command to shrink a window down to a miminal form in which only a small part of the 
title bar can be seen.    If you Minimize the DesignWave application window, it appears on the Windows task bar.    If
you Minimize a DesignWave part or drawing window, it appears at the bottom, just inside the DesignWave 
application window. You can also minimise a window by clicking on the left of the three icons at the right hand end 
of the title bar.    You can use the Restore command to reverse the effect of Minimize.

Maximize

You can use the Maximize command to enlarge a window to its maximum size.    Using Maximize on the DesignWave
application window enlarges the window to fill your entire desktop area.    You might want to do this if you are going
to be using DesignWave for some time and do not need to access other applications in the meantime.    Using 
Maximize on a part or drawing window, enlarges it to fill the area inside the DesignWave application window, 
covering all other part and drawing windows. You can also maximise a window by double-clicking on its title bar, or 
by clicking on the middle of the three icons at the right hand end of the title bar.    You can use the Restore 
command to reverse the effect of Maximize.

Close

For the DesignWave application window, the Close command is equivalent to choosing the Exit command on the 
File menu.    For a part or drawing window, it is equivalent to choosing the Close command from the File menu.    
You can also close a window by double-clicking on the icon at the left end of the title bar, or by clicking on the right
of the three icons at the right hand end of the title bar.

Next

The Next command is only available on part or drawing window, not on the DesignWave application window.    You 



can use the Next command to cycle through the part and drawing windows.



Part Window

You clicked on a part window.



Drawing Window

You clicked on a drawing window.




